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1   Introduction 

 
The Pulse Compression feature of Luna’s Optical Vector Analyzer (OVA) software can 
be used to compress the impulse response of a device under test (DUT) by 
mathematically removing dispersion effects from the measured device response. 
Removing the effects of dispersion can narrow and sharpen features in the time-delay 
domain that are broadened by dispersion. It can also enable highly dispersive devices, 
such as some dispersion compensation gratings or modules, to be characterized by the 
OVA. Without pulse compression, the OVA optical network accommodates impulse 
response durations of 6 ns or less if the DUT is measured in transmission and half or 
less of that value if it is measured in reflection. 
 

2   Dispersion 

 
Dispersion causes different wavelengths to travel at different velocities in a medium. [1] 
One consequence of this is that pulses broaden, and can change shape, as they 
propagate. The device response measured by the OVA includes both amplitude and 
phase data. Dispersion effects alter the phase, rather than the amplitude of the device 

response. Dispersion occurs because the index of refraction of the medium, n(), is 

dependent on optical frequency,  (wavelength, ). Because the phase of the 

propagating light is directly proportional to the refractive index, the phase, , is also 
dependent on frequency, 

            𝜙(𝜔) =
𝜔𝑛(𝜔)

𝑐
𝐿                                                                   (1) 

 

where L is the length of the medium, and c is the speed of light in vacuum.   
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It is common to express the frequency-dependent phase in terms of a Taylor series, 

where o is a specific frequency of interest, 
 

  𝜙(𝜔) = 𝜙𝑜 +
𝑑𝜙

𝑑𝜔
∙ (𝜔 − 𝜔𝑜) +

1

2
(
𝑑2𝜙

𝑑𝜔2) ∙ (𝜔 − 𝜔𝑜)
2 +

1

6
(
𝑑3𝜙

𝑑𝜔3) ∙ (𝜔 − 𝜔𝑜)
3 +⋯         (2a) 

 

  𝜙(𝜔) = 𝜙𝑜 + 𝜏𝑔(𝜔) ∙ (𝜔 − 𝜔𝑜) +
𝐶𝐷(𝜔)

2
∙ (𝜔 − 𝜔𝑜)

2 +
𝑇𝑂𝐷(𝜔)

6
∙ (𝜔 − 𝜔𝑜)

3 +⋯        (2b) 

 

The zeroth-order term, o, is a constant phase shift and does not affect dispersion. The 

first-order term contains the group delay, g, which is calculated by computing the first 
derivative of the phase with respect to frequency. Changes in the group delay cause a 
shift in the time-domain device response but do not affect dispersion. Terms of second-
order and higher do affect dispersion, and the impulse response compression feature of 
the OVA allows the user to mathematically remove dispersion effects related to the 
second and third order terms from the measured device response.  
 
The second order term contains the group velocity dispersion, or chromatic dispersion 
(CD), which is frequently described in the literature by a related parameter known as the 
dispersion coefficient. It describes the broadening of the pulse due to dispersion. The 
third order term (TOD), is the slope of the dispersion coefficient, and, when its value is 
non-negligible, dispersion not only broadens but also alters the shape of the pulse. (e.g. 
a pulse with an initially Gaussian shape would not keep its Gaussian pulse shape as it 
propagates through the optical network.) 
 

3   Pulse Compression Implemented by the OVA: An Overview 

 
Finding the optical frequency-domain transfer function of the device requires first finding 
the time-domain impulse response. [2] [3] Fourier transform techniques are used to 
convert between the time-domain impulse response and the frequency-domain transfer 
function of the DUT. The device response measured by the OVA is processed to yield 
four individual time-domain impulse response elements. The impulse response 
elements are separated from one another in the time-domain by delay lengths 
determined by the geometry of the OVA’s optical measurement network. The OVA uses 
windowing techniques to select and isolate the individual elements. After transforming 
each time-domain element into the frequency domain, these four elements collectively 
compose the transfer function of the device. 
 
The OVA optical network accommodates impulse response durations of 6 ns or less if 
the DUT is measured in transmission and half or less of that value if it is measured in 
reflection. This separation time is sufficient for most fiber optic components, as typical 
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impulse response durations do not exceed 1 ns. However, highly dispersive devices, 
such as some dispersion compensating modules, have longer impulse response 
durations. If the impulse response of the DUT is longer than the maximum temporal 
separation accommodated by the OVA, the individual elements of the transfer function 
overlap in the time domain and cannot be separated. This corrupts the computed 
transfer function of the DUT. Because of the limit on the maximum impulse response 
duration, when the OVA is used to characterize highly dispersive devices it is necessary 
to compress the impulse response of the device. 
 
Impulse response compression can also be used to mitigate dispersion effects that 
obscure device features of interest. Even when the time-domain impulse response of 
the device falls within the limit defined by the OVA, the dispersion accumulated by 
signals propagating through the device may be unacceptably high. This may be the 
case when it is of interest to directly compare two similar events which occur at different 
positions in the device, such as when one occurs near the proximal end and the other 
near the distal end of the DUT. Dispersion effects would differently affect the evolution 
of light from the two and complicate the comparison and characterization process. 
 
Impulse response compression is performed on the measured device response data 
before the Jones matrix (transfer function) of the DUT is computed. The pulse 
compression feature computes a phase correction term from user-input values of the 
average group velocity dispersion, da, and the slope of the dispersion coefficient, ds. 
One approach for obtaining these values is to compute them from mathematical fits 
made to the group delay data of the device. Referencing Equation (2), if the phase of 

the device is expressed as, poly, where the coefficients a, b, da, ds, and f are constants, 
 

𝜙𝑝𝑜𝑙𝑦(𝜆) = 𝑎 + 𝑏 ∙ (𝜆 − 𝜆𝑜) +
1

2
𝑑𝑎 ∙ (𝜆 − 𝜆𝑜)

2 +
1

6
𝑑𝑠 ∙ (𝜆 − 𝜆𝑜)

3 +
1

24
𝑓 ∙ (𝜆 − 𝜆𝑜)

4 +⋯       (3) 

 

then the derivative, which is the group delay, GDpoly, is  
 

   𝐺𝐷𝑝𝑜𝑙𝑦(𝜆) = 𝑐𝑜𝑛𝑠𝑡 + 𝑑𝑎 ∙ (𝜆) +
1

2
𝑑𝑠 ∙ (𝜆 − 𝜆𝑜)

2 +
1

6
𝑓 ∙ (𝜆 − 𝜆𝑜)

3 +⋯                     (4) 

 

The slope of the linear fit to GDpoly is da, and the second order fit to {𝐺𝐷𝑝𝑜𝑙𝑦(𝜆) − 𝑑𝑎 ∙ (𝜆)} 

is ds /2. (Note: it is necessary to multiply the second order fit coefficient by two (2) to 
obtain ds.) Impulse response compression is implemented by subtracting the constant 
values da and ds from the appropriate elements in the phase of the device response 

measured by the OVA to give a residual phase response, r,  
 

𝜙𝑟(𝜆) = 𝜙𝑜 + 𝜏𝑔(𝜆) ∙ (𝜆 − 𝜆𝑜) +
𝐶𝐷(𝜆)−𝑑𝑎

2
∙ (𝜆 − 𝜆𝑜)

2 +
𝑇𝑂𝐷(𝜆)−𝑑𝑠

6
∙ (𝜆 − 𝜆𝑜)

3 +⋯                 (5) 

 

When pulse compression is enabled, the chromatic dispersion calculated by the OVA, 
CDpc, will be the actual chromatic dispersion, CD, less a correction term, 
 

         𝐶𝐷𝑝𝑐(𝜆) = 𝐶𝐷(𝜆) − (𝑑𝑎 + 𝑑𝑠 ∙ (𝜆 − 𝜆𝑜)),                                  (6) 
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and the calculated group delay, GDpc, will be the actual group delay, GD, less an 
integrated correction term, 
 

                                  𝐺𝐷𝑝𝑐(𝜆) = 𝐺𝐷(𝜆) − (𝑑𝑎 ∙ 𝜆 +
1

2
𝑑𝑠 ∙ (𝜆 − 𝜆𝑜)

2).                               (7) 

 
If the transfer function computed using pulse compression is to be used for modelling 
purposes, it is necessary to expand the impulse responses to their original states. This 
can be done by multiplying each element of the Jones matrix by the complex conjugate 
of the phase correction term in the frequency domain. 
 
Once enabled, impulse response compression is applied to all subsequently 
acquired measurements. Measurements that have been acquired previous to 
enabling pulse compression are not altered. 
 

4   Using Impulse Response Compression to Sharpen DUT Features  

 
When dispersion obscures the characteristics of a feature of interest in the time-delay 
domain, pulse compression can be used as a tool to remove either or both the average 
dispersion and the slope of the dispersion from the transfer function computed for the 
DUT. This section treats the case in which the impulse response duration of the DUT 
falls within the limits accommodated by the OVA, so that the transfer function of the 
device can be accurately computed by the OVA without using pulse compression. (The 
case when the impulse response duration of the DUT is wider than the extent permitted 
by the OVA is addressed in the next section.) 
 
Implementation of pulse compression under these conditions is demonstrated using 
OVA transmission measurements taken of an approximately 60 m long length of low 
bend-loss singlemode optical fiber, which exhibits higher levels of dispersion than the 
standard singlemode optical fiber that is more common in telecommunications 
networks. In addition, although the fiber is not intended to exhibit birefringence, its 
custom over-coating results in the orthogonal polarizations of the fundamental mode 
propagating at slightly different speeds. Because of the coating-induced stress-
birefringence effects, the time-delay domain impulse response is expected to exhibit a 
dual lobe as a result of polarization mode dispersion (PMD). Measurements were taken 
to characterize the birefringence induced in this optical fiber. 
 
After measuring the fiber using the OVA’s transmission mode and optimizing the width 
of the time domain window, the time-delay domain impulse response of the DUT, 
plotted in the top graph of Figure 1, was examined. The pulse is recognized as 
broadened and its amplitude is modulated. While the modulation of the pulse creates a 
dual lobed structure near the peak, these sub-peaks did not result from the effects of 
PMD. This is confirmed by examining the PMD calculated for this DUT, which is plotted 
at the bottom of Figure 1; the PMD level is substantially less than the separation of the 
sub-peaks of the time-delay domain impulse response. The group delay, shown in 
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Figure 2, exhibits a well-defined linear slope. This indicates that pulse compression can 
be used as a tool to remove dispersion effects. 
 
 

 
Figure 1. Insertion Loss and Time Domain Amplitude, Compression not Enabled 

 
The pulse compression feature requires the user to input a reference wavelength, an 
average dispersion, and a dispersion slope. It is possible to find the average dispersion 
and dispersion slope parameters using the group delay, chromatic dispersion, and/or 
phase data. When working with the data, a number of different techniques may be used 
to find parameter values, including trial-and-error, estimation, and calculation. 
Estimation and trial-and-error techniques are performed using the OVA software. More 
exact calculations of the parameter values require saving OVA data to file and 
manipulating the data in a spreadsheet or in other curve analysis software. This section 
shows how the average dispersion may be estimated using the OVA’s group delay data 
plot, and it demonstrates the calculation of both parameters from the group delay data. 
 
The average dispersion parameter, da, is both the slope of the group delay and the 
mean value of the chromatic dispersion. The average dispersion parameter can be 
estimated using the OVA’s group delay plot as shown in Figure 2. With the cursors 
positioned to select points near the beginning and end of the spectrum, the average 
group delay, da , is estimated to be ~ -0.77 ps/nm by dividing the difference in group 
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delay by the corresponding difference in wavelength. Note that as the group delay is 
measured over a specified length of fiber, the units of this parameter are [ps/nm] rather 
than [ps/nm · km].  
 
The slope of the dispersion coefficient, ds, is the slope of the chromatic dispersion data. 
This parameter can be estimated from the chromatic dispersion graph using a 
procedure similar to that used to estimate da from the group delay plot. For this device, 
there was no discernable slope on the chromatic dispersion data. 
 
While the chromatic dispersion plot can be used to estimate both da and ds, this may not 
be the preferred approach. The chromatic dispersion is calculated by taking the 
derivative of the group delay data, which results in the signal noise appearing more 
pronounced in the chromatic dispersion data. The value of da is frequently estimated 

more accurately and easily using the group delay graph.  
 
 

 
Figure 2. Group Delay with Cursors Positioned to Estimate Slope 

 
When it is necessary to determine the values of the pulse compression parameters 
more accurately than is possible using graphical estimation techniques, the parameters 
can be calculated from data saved to text file from the OVA. The calculations are 
performed in a spreadsheet or other program capable of curve analysis. As mentioned 
previously, the parameters may be calculated from phase, group delay, and chromatic 
dispersion data. The following procedure demonstrates a method that uses the group 
delay data.  
 
The first step is to save the group delay data from the OVA to a text file. It is possible to 
specify which data files the OVA will save to file by accessing the ‘Select Data Save 
Options’ under the ‘File’ tab. When this window, shown in Figure 3, is open, ensure 
there is a check beside the Group Delay item. 
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Figure 3. Configuring Data Options to Save Group Delay Data to a Text File 

 
After the data file is opened in the curve analysis program, the average dispersion and 
the dispersion slope can be calculated. As was illustrated using the graphical method, 
the average dispersion, da [ps/nm], is calculated by determining the slope of a line fit to 
the group delay data. 
 
The first step in calculating the dispersion slope, ds [ps/nm2], from the group delay data 

is subtracting the linear term, da∙, from the group delay data: 
 

𝐺𝐷𝑀𝑜𝑑(𝜆) = 𝐺𝐷(𝜆) − 𝑑𝑎 ∙ 𝜆.                                             (8) 
 

The next is to rescale the x-axis by subtracting ref from , where ref is defined as the 
center of the wavelength window. The second order coefficient is then found by 

performing a second order fit to GDMod as a function of (-ref). Referencing Equation 
(4), the dispersion slope, ds, is two (2) times the second order coefficient. 
 

Following this procedure resulted in the calculation of da = -0.7693 [ps/nm], which 
agrees well with the value found using the graphical method, and a negligible value for 

ds for the low bend-loss fiber. As the group delay affects the entire spectrum of this 
device, the reference wavelength was taken to be equal to the center wavelength of the 
measurement scan, 1550 nm.  
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With values of the average dispersion and the dispersion slope determined, the pulse 
compression feature can be enabled and customized for this DUT. This is done by first 
selecting the ‘Specify Compression Settings’ feature in the ‘Options’ tab, as shown at 
the top of Figure 4, and then entering the data corresponding to this DUT, as is shown 
in the image at the bottom of the figure. It is also necessary to toggle the Pulse 
Compression Status button to ‘Enabled’ for pulse compression to be applied to all 
subsequent measurements. Changes made to these settings will not affect previously 
acquired measurements. 
 
 

 
 

 
Figure 4. Enabling and Specifying Values for the Compression Option 

 
 
Prior to making a measurement of the device with the pulse compression feature 
enabled, the original uncompressed data were copied into Matrix B using the Memory 
Matrix Functions block on the front panel. The OVA writes new measurement data to 
Matrix A, which overwrites the previously-acquired measurement data residing in Matrix 
A. Moving the original measurement data to Matrix B allows this uncompressed device 
data to be retained and compared to the device data calculated with the pulse 
compression feature enabled. The insertion loss and group delay data calculated from 
the uncompressed and compressed impulse responses are plotted in Figure 5. The 
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data calculated from the original uncompressed measurement are plotted in red and the 
data calculated from the subsequently-acquired compressed impulse response are 
plotted in blue. Both traces are plotted on the same graph by selecting Matrix A and 
Matrix B in the Active Matrices area of the Matrix Memory Functions block. 
 
 

 
Figure 5. Effects of Compression on Insertion Loss and Group Delay 

 
The time-delay domain amplitudes of the two are shown in Figure 6. As in Figure 5, the 
curve corresponding to the uncompressed impulse response is plotted in red and that 
corresponding to the compressed impulse response is in blue. With pulse compression 
enabled, the calculated impulse response is narrower and possesses a greater 
maximum amplitude than that calculated without pulse compression. In addition, the 
compressed impulse response exhibits features obscured by the effects dispersion in 
the uncompressed data. The dual lobes of the compressed impulse response cannot be 
discerned in the uncompressed impulse response. The separation of the sub-peaks of 
the compressed impulse response is consistent with the average PMD measured for the 
device and are indicative of the birefringence present in the DUT. 
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Figure 6. Effects of Compression on the Time Domain Amplitude 

 
 

5   Using Impulse Response Compression to Characterize Highly Dispersive 
Devices 

 
Compression can allow highly dispersive devices to be characterized by the OVA. 
When the impulse response duration of the DUT is wider than the extent 
accommodated by the OVA, the impulse response calculated by the OVA is corrupted 
and typically has an unusual appearance when plotted. The impulse response 
calculated for a dispersion compensation module (DCM), which has a manufacturer-
specified 10 ns/nm dispersion over the 1549 nm to 1551 nm spectral range, is shown in 
Figure 7. This measurement was acquired, with the compression feature disabled, while 
the OVA was operating in transmission mode. Because the impulse response is 
corrupted, the phase, group delay, and chromatic dispersion data calculated from the 
corrupted impulse response are also corrupted. It is therefore not possible to directly 
use these OVA data to calculate the average dispersion, da, and the dispersion slope, 
ds. of the device. Graphs of the corrupted insertion loss and group delay data are shown 
in Figure 8.  
 
One method of implementing pulse compression under these circumstances is to use a 
combination of trial-and-error and estimation to identify serviceable values for the 
average dispersion and dispersion slope parameters. If the approximate dispersion of 
the device is known, its value can be used to enable the compression option as shown 
in Figure 4. Then a second measurement scan can be acquired. If the compressed 
impulse response duration computed from the second measurement is less than the 
upper limit set by the OVA, the operator can then choose to further refine the 
compression parameters, using the techniques described in the previous section, or to 
characterize the device without making further modifications to the compression 
parameters. 
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Figure 7. Corrupted Uncompressed Impulse Response of a Highly Dispersive DUT 
 
  

 
Figure 8. Corrupted Insertion Loss and Group Delay of a Highly Dispersive DUT 
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The pulse compression parameters may also be calculated from device measurement 
data. If this option is preferred, it is recommended that the device be interrogated using 
the optical frequency domain reflectometry (OFDR) software. The OVA software should 
be exited before opening the OFDR software. The calculation approach may be 
preferred if little is known about the device dispersion, or if it is important to more 
accurately determine the values of the average dispersion and dispersion slope.  
 
The OFDR measurement technique is compatible with devices that possess wider 
impulse responses than are accommodated by the OVA. The OFDR software allows the 
group delay and other parameters of highly dispersive devices to be measured and 
saved to text file. Figure 9 shows the time-delay domain amplitude of the DCM over the 
full measurement range. The narrow peak at approximately 29 ns is the reflection from 
the optical connector at the input of the DCM, the wide feature centered at 
approximately 83 ns is the DCM, and the narrow peak at approximately 98 ns is the 
optical connector at the output of the DCM. 
 

 
Figure 9. OFDR Measurement of the DCM 

 

As is shown in Figure 10, the group delay is calculated by adjusting the x-axis span to 
better view the DCM feature, enabling the cursors, positioning one cursor at the center 
of the feature, setting the integration width to encompass the entire feature, and 
calculating the group delay. The calculated group delay appears in the lower graph. 
Unlike the low bend-loss fiber examined in the previous section, whose passband 
extended over the entire examined spectral range, the passband of the DCM is 
restricted to approximately the region between 1549 nm and 1551 nm.  
 
Cursors in the OFDR software can be used to estimate the average dispersion (group 
delay slope, da) from the group delay data in the manner illustrated in Figure 2 of the 
previous section. When this is done, group delay data points at either end of the 
passband, rather than at either end of the wavelength range, should be selected. It is 
also possible to save the computed group delay data from the OFDR software to file so 
that it can be manipulated in a spreadsheet or other data analysis software. Before 
saving the data file, ensure the group delay data will be included by opening the ‘Select 
Data File Options’ under the ‘File’ tab. Checks should appear next to Save File for 
Lower Graph and Group Delay, as indicated in Figure 11. 
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Figure 10. Calculating Group Delay Using the OFDR Software 

 

 
Figure 11. Configuring Data File Saving Options in the OFDR Software 

Cursor Positioned at 
Center of Feature 

Set Integration Width 

Calculate Button 
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The average dispersion and the dispersion slope, ds, can be calculated from the saved 
group delay data using the procedure outlined in the previous section, which follows 
Figure 3. These calculations were performed using only the group delay data falling 
between the edges of the DCM passband, 1549 nm to 1551 nm. The reference 

wavelength, ref, coincides with the center of the passband and is 1550 nm. The 
average dispersion, da, is found to be equal to the quoted value, -10,000 ps/nm, and the 
slope of the dispersion, ds, has a calculated value of -208.30 ps/nm2. 
 
After closing the OFDR software, the OVA software can be opened and the pulse 
compression option configured. The average dispersion, dispersion slope, and 
reference wavelength parameters are entered and pulse compression is enabled, as 
shown in Figure 12. 
 
 

 
Figure 12. Customizing the Pulse Compression Parameters for the DCM 

 
With the pulse compression feature enabled, a measurement of the DCM was acquired. 
The compressed impulse response of the device is shown in Figure 13. Unlike the 
uncompressed and corrupted impulse response shown in Figure 7, the compressed 
impulse response has a well-defined extent and its duration is comfortably 
accommodated by the OVA. The insertion loss and group delay calculated using the 
compressed impulse response are shown in Figure 14. With the removal of the average 
dispersion and slope of the dispersion from the phase of the device response, the 
effects of the higher order dispersion terms on the group delay are better revealed. 
Pulse compression also has the effect of flattening the insertion loss. 
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Figure 13. Impulse Response of the DCM Obtained Using Compression 

 

 
Figure 14. Insertion Loss and Group Delay of DCM with Compression Enabled 
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6   Summary of the OVA Compression Option 

The pulse compression feature subtracts user-specified constant values from the 
second and third order dispersion terms of the device response, which results in the 
calculation of a compressed time-domain impulse response. Enabling the compression 
feature is mandatory for obtaining uncorrupted measurements for highly dispersive 
devices: the OVA optical network accommodates impulse response durations of 6 ns or 
less if the DUT is measured in transmission and half or less of that value if it is 
measured in reflection. In addition, pulse compression can be used as a tool to sharpen 
features broadened by devices with lesser levels of dispersion. 
 
The two parameters the OVA uses to mathematically compress the impulse response 
are the slope of the group delay (average dispersion) and the dispersion slope. These 
can be found from the device’s phase, group delay, or chromatic dispersion data. This 
document demonstrates how they may be obtained from the group delay of the DUT. If 
the device is highly dispersive and an uncorrupted calculation of the impulse response 
cannot be obtained with the OVA software, the data necessary to compute the pulse 
compression parameters can be obtained using the OFDR software.  
 
The pulse compression feature was shown to sharpen the impulse response of a length 
of dispersive and slightly birefringent fiber. Compression was not necessary to allow the 
OVA to calculate an uncorrupted impulse response, but compression was necessary to 
sharpen and reveal the dual-peaked structure of the impulse response. Pulse 
compression was also demonstrated to allow a highly dispersive DCM to be 
characterized by the OVA. As the total delay, ~ 20 ns, of the DCM could not be 
accommodated by the OVA, the pulse compression parameters were calculated from 
the group delay data obtained from the OFDR software. These parameters were used 
to configure the OVA’s pulse compression feature, which enabled the DCM to be 
characterized by the OVA. 
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8   Product Support Contact Information 

 
Luna Products    3155 State Street 

and Engineering:  Blacksburg, VA  24060 

 

Main Phone:      1.540.961.5190 

Toll-Free Support:  1.866.586.2682 

Fax:       1.540.961.5191 

Email:      solutions@lunainc.com 

Website:     www.lunainc.com  

 

Specifications of products discussed in this document are subject to change without notice. For 

the latest product specifications, visit Luna’s website at www.lunainc.com.  
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